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Schematic of the BBB Model Chip. Apical chamber (outer channels) are for culture of vascular 
(endothelial cells) while basolateral chamber (central chamber) are for culture of brain tissue cells 
(astrocytes, pericytes, neurons). Porous architecture enables communication between the vascular 

and tissue cells. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

 

 

Overview of the SynBBB Model 
 

Delivery of neuroprotective or therapeutic agents to specific regions of the brain presents a major 
challenge, largely due to the presence of the Blood-Brain Barrier (BBB). Physiologically, the BBB 
consists of an intricate network of vascular endothelial cells (ECs) that isolate the central nervous 
system (CNS) from systemic blood circulation. Traditional blood brain barrier (BBB) assays, such as 
the Transwell® model have significant limitations such as lack of physiological shear stress, real-time 
visualization capability and large amount of consumables in addition to cumbersome protocols. 

 

BBB model recreates the in vivo microenvironment by mimicking a histological slice of brain tissue 
cells in communication with endothelial cells across the BBB. This is the only in vitro BBB model 
that allows 

• Accurate in vivo hemodynamic shear stress 

• Real-time visualization of cellular and barrier functionality 

• Significant reduction in cost and time 

• Robust and easy to use protocols 

This model has been successfully demonstrated for upregulation of tight junction molecules, 
functional assays (Prabhakarpandian et al., 2013) and validated against in vivo studies showing 
excellent correlation with permeation of small molecules (Deosarkar et al., 2015). 

 

Material, Equipment and Cells Required 

• BBB Chips* (Catalog # 102005): Use Ports A, C and E as Inlets and B, D and F as Outlets 

• Pneumatic Primer Device (Catalog #205001) - optional 

• 1 mL BD plastic syringes or other 1 mL syringes (Catalog # 203004) 

• 24 gauge blunt tip needles (Catalog # 204002) 

• Tygon microbore tubing, 0.02” ID X 0.06” OD (Catalog # 201005) 

• Clamps (Catalog # 202003) 

• Forceps 

• Syringe Pump capable of flow rates from 10nl/min to 10ul/min 

• Fibronectin 

• Endothelial Cells (primary or cell line) 

• Astrocytes (primary or cell line) 

 
 
 
 

* Store at Room Temperature. Shelf life is 6 months at room temperature 



 

 

 

 

The following protocol should be carried out within a laminar flow hood to maintain sterility. 
 

Culture of Endothelial Cells in the Apical Channels 
 
Shear-induced endothelial cell tight junctions, which cannot be achieved in the Transwell® model, are 

easily achieved in this model using fluid perfusion. Formation of tight junction changes can be 
measured using biochemical or electrical analysis (assessing changes in electrical resistance) with 
the SynVivo Cell Impedance Analyzer (Catalog # 304001). 

Note: Most primary endothelial cells are usable only until passage 8. For endothelial cell lines, refer to 
vendor specifications for passage information. Most endothelial cell lines do not sustain shear stress 
that is required for formation of tight junctions. 

 

A. Coating The Chip with Endothelial Cell Culture Matrix (e.g. fibronectin). This process is 

performed using Pneumatic Primer (Cat# 205001). 

1. Place approximately 1 inch long segments of Tygon tubing into the outlet ports of the chip. 

2. Draw 200ug/ml human fibronectin into a 1 mL syringe. 

3. Using additional 1inch long segments of tubing, fill the chip with liquid by inserting the primed 

tubing into the inlet and pushing the solution through until the outlet tubing is filled. 

4. Do this for all but one inlet port. For this last port, use a tubing approximately 2-3 inch long. 

When the chip is filled, unlock the needle from the syringe, leaving the needle attached to the 

tubing. 

5. Clamp all tubing below the liquid line, except for the tubing with the needle attached. 
6. Connect the chip to the Pneumatic Primer by locking the needle into the LuerLock connector 

on the box. Note: Multiple chips can be primed simultaneously using the multiple port 

manifold (cat # 207001) 

7. Turn the knob on the controller box and adjust the pressure to ~5-7 psi. Apply the pressure 

for ~5-20 minutes.  Chips will take at least 15 minutes to completely fill. 

8. Turn off the pressure and cut the Tygon tubing connected to the Pneumatic Primer. 

9. Allow the chip to incubate at 37° for a minimum of 1 hour before use. 

10. Flush fresh media into chip just before seeding endothelial cells. 

 
B. Culture of Endothelial Cells 
1. Prepare the endothelial cell suspension for seeding. Endothelial cells should be dissociated, 

centrifuged and concentrated to approximately 5-8x106cells/ml in cell specific media. 

2. Place a drop of water at the base of the inlet port tubing to be removed and gently remove 

the tubing from the port. 



 

 

3. Remove the clamp on the outlet port. All channels should be clamped except for the channel 

being seeded. 

4. Prepare a syringe and tubing with the previously prepared cell suspension and mount onto a 

syringe pump. 

5. Ensure that the tubing is free of air bubbles and the cell mixture is flush with the end of the 

tubing 

6. Insert the tubing into the port - the drop of water will prevent air entering the chip as the 

tubing is inserted. 

7. Clean the fluid from the surface of the chip. 

8. Begin the injection at 4-7 ul/min. 

9. Watch the chip as the cells are flowing. Once the vascular channel is filled with cells, stop the 

flow and clamp the outlet tubing. 

10. Carefully and quickly cut the inlet tubing, keeping the length of all the tubing equal. 

11. Allow the cells to attach for at least 4 hours before changing media. 

a. Many endothelial cells can be incubated overnight before a media change is required. 

12. Allow the cells to grow approximately 24 hours with at least 1 media change before running 

migration assay. 

a. It should be noted that some endothelial cells may need up to 72 hours (with daily 

media changes) before they can withstand flow. 

 
b. To set up a media change program using a syringe pump, use the following steps: 

i. Program the pump to flush out the vascular channel without cells every 3 
hours at 2µl/min for 3 minutes to refresh the media. 

1. Program summary:  Media Change 
a. Step 1:  Constant Rate 

i. Mode: Infuse 

ii. Set rate:  2 µl/min 

iii. Time:  0:03:00 (3 minutes). 

b. Step 2: Pause 

i. Mode: Pause 

ii. Target time:  3:00:00 (3 hours) 

c. Step 3:  Repeat from Step 1 
13. For complete confluent monolayers, introduce flow using programmable syringe pump with 

the flow rate climbing from 0.01µl/min to 1µl/min over a 24-hour period (Table 1). 

 
a. The program example uses the “Step” feature of the pump, which infuses media at a 

user-defined flow rate over a specific period of time. 



 

 

 
 

Table 1: Step programming to increase the flow rate from 0.01 to 1 µL/min over 24 hours 
 

SEQ Flow Rate (µl/min) Time (h:m:s) Direction 

1 0.01 2:00:00 INFUSE 

2 0.025 2:00:00 INFUSE 

3 0.05 2:00:00 INFUSE 

4 0.075 2:00:00 INFUSE 

5 0.1 2:00:00 INFUSE 

6 0.2 2:00:00 INFUSE 

7 0.3 2:00:00 INFUSE 

8 0.4 2:00:00 INFUSE 

9 0.5 2:00:00 INFUSE 

10 0.6 2:00:00 INFUSE 

11 0.8 2:00:00 INFUSE 
12 1 2:00:00 INFUSE 

Co-Culture of Endothelial Cells with Tissue Cells or Conditioned Media 
 

Interactions between brain tissue cells and endothelial cells are readily visualized in the SynVivo- 
BBB model. Endothelial cells are cultured under flow in the vascular channel, and the tissue 
chamber is cultured with primary brain cells, such as astrocytes. Endothelial cells co-cultured 
with astrocytes form significantly tighter cell junctions compared to mono cultured endothelial 
cells. 

 

1. All tubing should be clamped before beginning this procedure. 

2. Astrocytes should be dissociated centrifuged and concentrated to approximately 1-3x107 

cells/mL. 

3. Place a drop of water at the base of the inlet port (C) tubing to be removed. 

4. Gently remove the tubing - the water should cover the port once the tubing is removed, and 

should remain there until new Tygon tubing is inserted into the port. This step will prevent air 

from entering the chip. 

5. Remove the clamp on the outlet port (D). 

6. Prepare a syringe and tubing with the cell suspension and mount onto a syringe pump. 

7. Ensure that the tubing is free of air bubbles and allow a convex meniscus to form at the end 

of the tubing. 

8. Insert the tubing into the port (C)—the meniscus and the drop of water will form a bridge to 

prevent air from entering the chip as the tubing is inserted. 

9. Clean the fluid from the surface of the chip. 



 

 

 

10. Begin the injection at 5 µL/min. 

11. Observe the chip as the cells are flowing. Once the tissue chamber is filled with cells, clamp 

the outlet tubing (port D) and stop the flow. 

12. Cut the inlet tubing approximately 1 inch above the chip, and then clamp. This will help 

disperse the cells more evenly throughout the vascular chamber. 

13. Allow astrocytes to attach for at least 4 hours before changing media. 

14. Change media regularly until cells are confluent or time of experiments. 

15. For conditioned media from astrocytes or neurons, repeat above process without cells. 

 

 
Fluorescence Tagged Small Molecule Permeability Assay 

 

Unlike BBB models that are arranged in top to bottom architecture (i.e., Transwell), small molecule 
transport can be assessed and quantified in real-time across the SynBBB model due to its side-by-side 
architecture. A fluorescently labeled drug molecule of interest is perfused through the vascular 
channels at physiological flow rate. Real-time videos are acquired and analyzed to calculate the rate   
of permeability into the tissue chamber. Different rates of permeability are observed across the BBB 
due to tight junctions of endothelial cells. Permeability through the vascular channel into the tissue 
chamber is measured by observing diffusion of a fluorescently labeled molecule. The permeability is 
related to the rate of change of fluorescent intensity in the tissue chamber by the equation [1]: 

𝑃  = (1 − 𝐻 
)  

1  𝑉 𝑑𝐼! 
 

  

(1) 
!"   𝐼!! 𝑆  𝑑𝑡 

 
 

HCT is the hematocrit count (equal to 0 for in vitro measurements), Iv0 is the fluorescent intensity in    
the apical channel containing the endothelial cells, V/S is the ratio of apical volume to surface area (in 
this case, calculated for a 200 µm wide and 100 µm height vascular channel), and It is the fluorescent 
intensity in the basolateral chamber. 

Parameter Description Value 
HCT Local Hematocrit 0 (in vitro) 
IV0 Apical Intensity Calculated below 

V/S Ratio of Apical Volume to Surface Area 0.1 cm 

dIt/dt Change in Basolateral Intensity over 
Time 

Calculated below 

 

A. Video Acquisition 
1. Prepare a desired concentration fluorescent-tagged molecule (e.g. 0.1 mM FITC-Dextran 

(3kDa)) solution in PBS, and load the solution into a 1 cc syringe with a 24 gauge needle 



 

 

attachment with Tygon tubing. Set the syringe on the syringe pump and fully perfuse the 

tubing with the solution. 

2. Place the cell-coated chip onto the stage of an epifluorescence microscope. Place a drop of 

water around the inlet tubing, and remove tubing. 

3. Set the camera exposure, and stage of the microscope to capture both the apical and 

basolateral channels of the chip in one image. 

4. Interface the perfused tubing containing the fluorescent small molecule to the chip, and begin 

flow at 0.1 uL/min. Immediately begin to acquire images every 30 s for 1 hour. (Note: close 

the fluorescence shutter between image acquisitions in order to prevent photobleaching). 

5. Save the image stack as an AVI. 

 
B. Video Analysis using ImageJ 

1. Open ImageJ and import the acquired video as an AVI: 

File→Import→AVI 
Select video file 
In the AVI Reader box, check “Use Virtual Stack” and click OK 
The horizontal scroll bar will allow you to scroll through the stack 

2. Using polygon selections tool, carefully outline the vascular channel geometry. You may need 

to scroll to a high contract section to clearly see the outline. 

 
 

3. Set the Measurements to measure the mean value of the selection: 

Analyze→Set Measurements 
Select “Mean Gray Value” 
Under “Redirect to”, select the file name 

4. Analyze the mean gray value of the stack: 



 

 

 

Plugins→Stacks→Measure Stack 
Copy data from “Results” window to Excel for analysis. Ivessel will be generated from this 
data. 

 

5. Deselect the vascular chamber, and select the tissue chamber using the elliptical selections 

tool. 

 

6. Repeat gray value measurement of the stack: 

Plugins→Stacks→Measure Stack 
Copy data from “Results” window to Excel for analysis. Itissue will be generated from this 
data. 



 

 

7. There should be three columns of data in Excel: the frame number, the Ivessel data and the 

Itissue data. Calculate time in seconds by multiplying each frame number by 3600 and 

dividing by the number of frames (121). 

8. Plot Ivessel vs. time in an Excel scatter plot. The plot should show an increase in Ivessel intensity, 

and then a plateau. Note the time point at the beginning of the plateau. The average gray 

value intensity of the plateau area will be Iv0 in Equation [1]. In this example, Iv0 = 142.5. 

 
9. Next, find the slope of Itissue vs. time. Only use data in the time range specified by the I0 

average above. Plot Itissue data in the y-axis, and time in the x-axis. Display the trend line with 

its equation on the graph to determine the slope. 

 
10. The slope of Itissue is equal to It/dt in Equation [1] to calculate permeability in cm/s. From the 

example above, It/dt =3.7 x 10-2 s-1. For the given example, Equation 1 is calculated: 

𝑃  =   1 − 0 
1

 
140.5 

 
0.1 𝑐𝑚 3.7x10!!𝑠   = 0.0121 𝑐𝑚/𝑠 
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Unless otherwise expressly stated on the Product or in the documentation accompanying the 
Product, the Product is intended for research only and is not to be used for any other purpose, 
including without limitation, unauthorized commercial uses, in vitro diagnostic uses, ex vivo or in 
vivo therapeutic uses. 
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